## Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Welcome to the ARIA Player</td>
<td>6</td>
</tr>
<tr>
<td>What is ARIA?</td>
<td>7</td>
</tr>
<tr>
<td>The ARIA-Based Sound Libraries</td>
<td>8</td>
</tr>
<tr>
<td>End User License Agreement</td>
<td>8</td>
</tr>
<tr>
<td>How to Use This Manual and Other Manuals</td>
<td>9</td>
</tr>
<tr>
<td>Further Documentation and Resources</td>
<td>10</td>
</tr>
<tr>
<td>Specifications &amp; Computer System Requirements</td>
<td>10</td>
</tr>
<tr>
<td>Regarding Sound Cards &amp; MIDI interfaces</td>
<td>12</td>
</tr>
<tr>
<td>Regarding Speakers, Amplification and Headphones</td>
<td>13</td>
</tr>
<tr>
<td>Regarding 64-bit Computing</td>
<td>13</td>
</tr>
<tr>
<td>INSTALLATION</td>
<td>14</td>
</tr>
<tr>
<td>Installing ARIA</td>
<td>15</td>
</tr>
<tr>
<td>Mac Setup (For Windows Setup See Next Section)</td>
<td>15</td>
</tr>
<tr>
<td>Windows Setup</td>
<td>19</td>
</tr>
<tr>
<td>1. The Setup Wizard</td>
<td>20</td>
</tr>
<tr>
<td>2. The ARIA Engine Installer</td>
<td>23</td>
</tr>
<tr>
<td>3. The ARIA Player Installer</td>
<td>23</td>
</tr>
<tr>
<td>4. The Sound Library Installer</td>
<td>24</td>
</tr>
<tr>
<td>ACTIVATION</td>
<td>27</td>
</tr>
<tr>
<td>Activating the ARIA Player</td>
<td>28</td>
</tr>
<tr>
<td>Log onto the Registration Site</td>
<td>29</td>
</tr>
<tr>
<td>Product Registration: Enter Your Serial Number</td>
<td>30</td>
</tr>
<tr>
<td>The Activation Keycard</td>
<td>31</td>
</tr>
<tr>
<td>Final Step: Activating Your Sample Library</td>
<td>32</td>
</tr>
<tr>
<td>Updating to Latest Version</td>
<td>34</td>
</tr>
<tr>
<td>HOW TO USE THE ARIA PLAYER</td>
<td>35</td>
</tr>
<tr>
<td>How to Use the ARIA Player</td>
<td>36</td>
</tr>
<tr>
<td>Using ARIA as a Standalone Application (‘Live’ Play)</td>
<td>36</td>
</tr>
<tr>
<td>Launching ARIA in Standalone Mode</td>
<td>36</td>
</tr>
<tr>
<td>Basic Setup Information for Standalone Mode</td>
<td>36</td>
</tr>
<tr>
<td>File Menu for Loading and Saving Presets in the Standalone</td>
<td>38</td>
</tr>
<tr>
<td>Tools Menu—Standalone Mode ONLY</td>
<td>38</td>
</tr>
<tr>
<td>MIDI File Player and Audio Recorder (Standalone Version Only)</td>
<td>40</td>
</tr>
<tr>
<td>Using the ARIA Player as an Instrument Plug-in</td>
<td>41</td>
</tr>
<tr>
<td>Basic Setup Information for Using the ARIA Player as a Plug-In Instrument</td>
<td>42</td>
</tr>
<tr>
<td>Using the ARIA Player in a Specific Music Program or Sequencer</td>
<td>43</td>
</tr>
<tr>
<td>Saving ARIA Player Parameters in a Music Program or Sequencer</td>
<td>43</td>
</tr>
<tr>
<td>VST Expression Support</td>
<td>44</td>
</tr>
<tr>
<td>Using ARIA with a Notation Program</td>
<td>44</td>
</tr>
</tbody>
</table>
Welcome to the ARIA Player

It’s an exciting time to participate in music technology! The pace of technological progress is astounding. We hear the fruits of this progress in movies, concerts, television, the internet, video games, and other forms of media. As computer power increases and as the world becomes more connected, we become the beneficiaries of this revolution.

The ARIA Player is a leader in this new music technology. The ARIA Engine and Player have been thoroughly tested and proven. They are currently used in major music programs including Microsoft Songsmtih, MakeMusic Finale 2010, SONY ACID Pro, and the AKAI EWI-USB. Steinway & Sons also chose the ARIA Engine for the Authorized Steinway Virtual Piano.

With the acquisition of Giga Technology, Garritan also acquired exclusive rights to the Wavestream Technology with the right to its hard-disc streaming and other cutting-edge technologies. Some of the Giga technologies are making their way into the ARIA Player.

This Guide is intended to give you a brief overview of the ARIA Player. In this manual, you’ll find instructions on how to set up the ARIA Player for use with your sound library. Please check our website at www.garritan.com for the latest up-to-date information, downloadable sounds, FAQs, troubleshooting, helpful hints, and tutorials.

It is my hope that Garritan and Plogue will enable you to make great music that will enrich your musical life.

Yours in music,

Gary Garritan
What is ARIA?

ARIA is a state-of-the-art software program that plays back the sounds of ARIA-based software musical instruments. A sound library or sample library contains the sounds of various instruments in digital form. A Player is the software that plays those sounds. This is very similar to MP3s that contain sound files, but an MP3 Player (like Windows Media Player, Winamp or iTunes) is needed to play those sound files. ARIA can play no sounds unless it is loaded with samples from one or more sound libraries that are compatible with ARIA (such as the Garritan sound libraries). When you install additional ARIA-compatible sound libraries on the same computer, they can all use the same ARIA engine.

ARIA was designed from the ground up for playability and musicality. The uniquely powerful and high-performance specialized ARIA engine was designed by Plogue Art et Technologie Inc. More than just playing back samples, the ARIA engine provides specially tailored acoustic programming designed to reproduce the sounds of actual instruments, and imparts expressive controls to those sounds. The focus of ARIA has been on control—the use of MIDI controllers to shape techniques and phrases for the various instruments.

The ARIA interface is mostly standardized across libraries. One notable exception is the Authorized Steinway Piano which requires specialized DSP and controls. With most other libraries, the look and feel remain relatively constant. Controls will be instrument-specific with varying controls and keyswitches to accommodate each patch.

The ARIA Engine can be run in two different modes—Standalone and Plug-in.
- As a standalone, the ARIA Engine will run as an independent program.
- As a plug-in, the ARIA Engine plugs into a host program, usually a sequencer or supported notation program.

Running as a standalone, only one instance of ARIA can be run at a given time. This will typically allow only 16 channels.

Used as a plug-in, it will be possible to open up multiple instances of the ARIA Engine at the same time. Each instance of ARIA will usually allow 16 channels. Running 8 instances will give you 128 instruments.
The ARIA-Based Sound Libraries

There is a growing number of sound libraries available for the ARIA Engine. ARIA uses the powerful, open-source SFZ format.

Each library will appear in the instrument slot and its associated instruments and groups will appear in a hierarchical folder structure. Details about each library and related instruments are provided in library-specific manuals.

End User License Agreement

Please read the terms of the following software licensing agreement before using this software. By installing and loading these products on your computer you acknowledge that you have read this license agreement, understand the agreement, and agree to its terms and conditions. If you do not agree to these terms and conditions, do not install or use the sounds contained herein. This is the complete agreement between you, Garritan Corporation and Plogue Art et Technologie Inc. and supersedes any other representations or prior agreements, whether oral or in writing.

An important thing to understand is that YOU ARE OBTAINING A LICENSE FOR YOUR USE ONLY—THE SOUNDS DO NOT BELONG TO YOU. The implications are described below. The sounds, samples and programming in the sound library remain the sole property of Garritan Corp. and are licensed (not sold) to you.

**What You May Do:** You may use these sounds in recordings, music productions, public performances, and other reasonable musical purposes within musical compositions. You may use these sounds in your own musical compositions as much as you like without any need to pay extra or obtain further permission. If you do use these sounds, we ask that you include the following courtesy credits in any written materials or credits accompanying your music that utilizes material from Garritan (CD booklet, film credits, etc.): “Instrument samples used in this recording are from Garritan”—or a similar credit where practicable. You are allowed a maximum of four (4) installations per purchase.

**What You May Not Do:** The enclosed sounds may not be re-used in any commercial sample library or competitive product. You are absolutely forbidden to duplicate, copy, distribute, transfer, upload, download, trade, or loan this software or any of the contents in any way to anyone. You may not redistribute this product in whole or in part through an archive, collection, through the Internet, or a binaries group, newsgroup, or any type of removable media, or through a network. You may not resell the product without written permission and payment of an additional fee. The sounds and samples contained within this software may not be edited, modified, digitally altered, re-synthesized or manipulated without direct written consent from Garritan.
**Disclaimers and Conditions:** A right to use any of the Garritan sounds is granted to the original end user only, and this license is not transferable unless there is written consent from Garritan Corporation and payment of an additional fee. The Garritan sounds will only work with the bundled ARIA Player and will not work with any other sampler. Licensor will not be responsible if the content of this disc does not fit the particular purpose of the Licensee. Please make sure before installing this item that it meets your needs. Information contained herein is subject to change without notice and does not represent a commitment on the part of Garritan Corporation. The sounds are licensed “as is” without warranties of any kind. Neither Garritan Corporation, Plogue Art et Technologie Inc., nor any agent or distributor can be held responsible for any direct or indirect or consequential loss arising from the use of this product in whatever form. The ARIA Engine is covered by the installer’s End User License Agreement and is incorporated by reference. This Garritan library may not be returned for any reason other than manufacturing defects. The terms of this license shall be construed in accordance with the substantive laws of the United States of America and the State of Washington. The user agrees to read the manual before seeking technical support and to make sure his or her system meets the recommended requirements. There are no refunds whatsoever on downloadable products.

**How to Use This Manual and Other Manuals**

This manual will help you learn how to use the ARIA Player and Engine. It should be viewed in addition to the manual of your particular sound library. This manual sets forth information primarily about the ARIA Player, whereas your sound library manual will provide more specific information about your sound library.

Although many dislike reading manuals, if you wish to get the most out of this new library it is absolutely essential to read the manuals. Doing so will help you understand how to use this software. The operation of many of the essential features is not obvious in casual use, and we realize many users are not music technologists. We’ll do our best to make this easier for you. We have attempted to make this manual easy to read and have provided information about the various instruments, playing techniques, and modes of control. And, of course, by no means can music or performance techniques be taught from this or any other manual. You can refer to this manual whenever you wish.

This manual is provided in digital form as an Adobe Acrobat document file (also known as a PDF) that can be viewed on a computer monitor or printed. If you do not have the Adobe Acrobat Reader, it is available free from [www.adobe.com](http://www.adobe.com). A digital manual is eco-friendly and can be easily updated. If you have a desire to have a paper copy, you can print this document. A printed copy can be a handy reference.
The easiest way to obtain the information you seek is to use the Bookmarks pane along the left side of this PDF document. By opening the Bookmarks pane, you can go to the various topics from the section names. With a PDF document, you can also zoom in to make the page larger to see more details, or zoom out to see multiple pages at once.

**Manuals for the Specific Sound Libraries**
Each library that uses the ARIA Player will have its own manual. For documentation on a specific library and its instruments, please refer to the separate documentation for each library. Separate PDF documents for your particular library are included in your purchase. You can also view each manual online at [www.garritan.com](http://www.garritan.com).

**Further Documentation and Resources**
For the latest information including updated documentation, please visit our support pages at: [www.garritan.com](http://www.garritan.com). There you can find updated information, corrections or additions to this manual, FAQ pages answering common questions, suggestions from the users of the ARIA software, and news about upcoming Garritan releases. You can also visit our forums for up-to-date information. The address is: [www.garritan.com/forums](http://www.garritan.com/forums). Please send any reports of errors in this manual or suggestions for improvement to info@garritan.com.

**Specifications & Computer System Requirements**
The following table lists the computer and hardware requirements for using the ARIA Player. You can use the ARIA Player on most any modern personal computer that meets the specifications listed below. The specifications provide the minimum standards. For optimal functioning, it is recommended you have a powerful enough computer with a fast CPU processor, a fast hard drive, and a large amount of RAM. The ARIA audio engine is designed to make use of the processing power of your computer's CPU. The powerful and complex algorithms of the ARIA Player work best on modern CPUs. We think that’s a small price to pay for the results you will get. Please also observe the systems requirements of your host application, notation program, and/or sequencing program if applicable. Please see our forums or website if you are looking for recommendations or for more information.
### Computer System Requirements

<table>
<thead>
<tr>
<th>Computer</th>
<th>Operating System</th>
<th>Hardware</th>
</tr>
</thead>
</table>
| Windows PC | Microsoft Windows XP (SP2 or SP3 recommended)                                    | • Core 2 Duo or better recommended  
• 2 GB RAM recommended to play most libraries optimally. There is a direct correlation between the number of instruments that can be loaded and the amount of available RAM.  
• Required free hard drive space will depend upon the sound library.  
• Hard drive speed of at least 7200 RPM preferred  
• Internet connection for download version, DVD ROM drive required for boxed version installation  
• Monitor with 1,024x768 resolution or better  
• A sound card compatible with ASIO, DirectSound, or MME  
• Keyboard: A MIDI interface may be required if you are using a MIDI keyboard. Some keyboards use USB. The Mod Wheel on the keyboard controls volume so make sure to move it up to an audible level. If you do not have a Mod Wheel, then have the ability to assign the controller within your notation program, sequencer, or external controller.  
• High-quality speakers and amplifier, or high-quality headphones  
• Internet connection for download, updates, and online registration |
| Mac        | Mac OS X 10.4 minimum (universal binary minimum)                                 | • Mac Intel recommended  
• 2 GB RAM recommended to play most libraries optimally. There is a direct correlation between the number of instruments that can be loaded and the amount of available RAM.  
• Required free hard drive space will depend upon the sound library.  
• Hard drive speed of at least 7200 RPM preferred  
• Internet connection for download version, DVD ROM drive required for boxed version installation  
• Monitor with 1,024x768 resolution or better  
• A sound card compatible with Core Audio  
• A MIDI interface may be required if you are using a MIDI keyboard. Some keyboards use USB. The Mod Wheel on the keyboard controls volume so make sure to move it up to an audible level. If you do not have a Mod Wheel, then have the ability to assign the controller within your notation program, sequencer, or external controller  
• High-quality speakers and amplifier, or high-quality headphones  
• Internet connection for download, updates and online registration |

The stated requirements represent minimum guidelines for the Standalone ARIA Player. If you are using the ARIA Player within a host music program, then there may be other additional resource requirements. Please also observe the system requirements of your host application, notation program, and/or sequencing program if applicable. The demands of various other processing software (including the sequencer, audio and effects processors, other plug-ins, and so on) can also affect functionality.
Regarding Sound Cards & MIDI interfaces

The quality of the audio interface will have a significant effect on the quality of the sound you will hear from the ARIA Player. It will also have a substantial effect on performance (both latency and polyphony). Therefore, a good sound card is one of the most important components in optimizing the sound and performance of the ARIA Player.

In theory, any audio or sound interface that the manufacturer supports for your operating system and computer, and that has good drivers, should work. However, you are unlikely to get the best sonic results from a sound card designed for computer games or system sounds. Most computers come with a consumer-grade sound card, and we recommend that you get a good quality sound interface beyond that which is built into your computer. Older SoundBlaster sound cards (that do not support multiple sample rates) and gamer-oriented or home system sound cards may be problematic. It is not possible for us to test all built-in or third-party sound cards, and some interfaces do have problems on some platforms, so please see the specifications page on our website if you are considering buying a new sound card to run the ARIA Player. Similarly, any MIDI interface the manufacturer supports for your system should work with the ARIA Player.

Technical Info

A low-latency audio interface with ASIO 2.0, WDM/WaveRT (Windows), or Core Audio (Mac) drivers is required for the ARIA Player to work as a standalone program. These drivers are normally installed with the audio interface, or the most recent versions can be acquired from the manufacturer’s website. Contact the manufacturer of your interface for more information. The drivers should be set to a buffer size of 256 samples (optimal) or 512 (more latency, but less CPU load) and 44100Hz Sampling Rate.

Please note:

When the ARIA Player is running as a plug-in, it uses the audio driver selected by the host’s setup. If the host (typically your sequencer or notation program) is set up properly and works well, then the ARIA Player plug-in should pass through the same audio and MIDI setup. For this information, please refer to your sequencer’s, notation program’s, or host’s manual.
Regarding Speakers, Amplification and Headphones

Amplifiers and speakers or headphones are needed to listen to the audio output that the ARIA Player produces through the computer's audio or sound card(s).

The quality of the audio amplifiers and speakers is extremely important; there is little point in expending a great deal on high-end computer systems and an audio interface—and using inferior personal computer speakers.

Regarding 64-bit Computing

The ARIA Player is 64-bit compatible and takes full advantage of the new Windows 64-bit operating systems, processors, and hardware that are available. Mac 64 bit is in development at the time of this writing. The ARIA Player is also fully 32-bit compatible. At this writing, 64-bit computing is entering the marketplace; but 64-bit hosts, audio and MIDI drivers have not fully penetrated the market. To be true 64-bit, the entire audio path must be 64-bit, including sampler, host, operating system, audio, and MIDI hardware. As more hosts, operating systems, and hardware become 64-bit enabled, the ARIA Player will work with those 64-bit platforms. Please also consult our website for further information and updated recommendations. Currently ARIA works with Windows 64 bit, but not yet with Mac 64 bit OS.
INSTALLATION
Installing ARIA

Installing ARIA is easy. Before you begin, make sure your system meets or exceeds the system requirements and that there is enough room on your hard drive to contain all the samples. The full installation can require several gigabytes of free hard disk space, depending upon the requirements of your sample library. Installation involves installing your library’s instrument samples as well as the advanced ARIA instrument engine. A setup program will guide you through the process step-by-step.

<table>
<thead>
<tr>
<th>3 Steps for Installing Garritan Concert &amp; Marching Band</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Step 1. ARIA Engine Installation</td>
</tr>
<tr>
<td>• Step 2. ARIA Player Installation</td>
</tr>
<tr>
<td>• Step 3. Sound Library Installation</td>
</tr>
</tbody>
</table>

Mac Setup (For Windows Setup See Next Section)

- First, make sure your audio and MIDI hardware are set up and working with your computer. Also close any programs you are running.
- For the Download version of your sound library, the Mac Archive Utility will unpack this to your default downloads directory.
- Double-click on MAC_[your library].mpkg. Accept the defaults on the installer. For DVD versions of your sound library, take the Installation disc out of its case, put it into your DVD drive in the computer, and close the drive tray.
- Double-click on the DVD icon, then on the installer.
If the setup screen does not automatically appear: Use the Apple Finder (Mac) to open the installation DVD; or for Download users, double-click on MAC_[your library].mpkg then double-click the Installer Icon.

You will then be asked to fill out your name and to read and accept the End User License Agreement before proceeding with the installation.

The setup lets you select which plug-in formats you require. These plug-in formats allow the ARIA Player, in addition to standalone use, to run as a virtual instrument plug-in that seamlessly integrates into your favorite music software program or sequencer (assuming that it accepts such instrument plug-ins). Please refer to the chapter “Using the ARIA Player as an Instrument Plug-In” for further information.

The choices are Audio Units, RTAS and VST
• You can select the folder into which the ARIA Player, your library, and support files should be installed. For most instances, use the default. If you prefer to install ARIA Player and your library in a location other than the default, click on “Change Install Location.”

• Setup is now ready to begin installing the ARIA Player along with your sound library. Click on “Install” to begin the installation process. Installing library files is very resource-intensive, and it may take some time to install all the samples.
• After a few moments a dialog box will notify you that the setup wizard has finished installing your sound library on your computer.

When sample installation is complete, you will need to authorize your sound library. This procedure is described in the next chapter.

When you are finished with installation, remove the disc(s) from your drive and store them in a safe place if you have the DVD version. If you purchased the Download version, be sure to make a backup copy. If anything happens to your computer, you can reinstall you sound library from the discs or the backup.

**IMPORTANT!**

Please do not cancel setup after installation begins, otherwise a partial, broken installation may result.
Windows Setup

The setup in Windows installs four components:

1. The Setup Wizard
2. The ARIA Engine Installer
3. The ARIA Player Installer
4. The Sound Library Installer

The four component installations will be successive and it is recommended that you just select “Next” for each screen and use the defaults.

- First make sure your system meets or exceeds the system requirements. See the previous section of this manual for the system requirements. Also make sure your audio and MIDI hardware is set up and working with your computer.
- Close any programs you are running.
- For the Download version of your particular library after download, unzip by double-clicking the zip file for your library. Make sure you fully unzip the entire file. Do not run the EXE file through Windows’ compressed folder or Winzip directly. In the downloaded zip file you will see these items:

![Image of zip file contents]

Note:

If unzipping is unsuccessful with the Windows utility, you may want to try Winzip or another free unzipping utility.
1. The Setup Wizard

- Run WIN_[Your Library].exe from the location where you extracted the files.

For DVD versions, take the Installation disc out of the case, place it into your DVD drive in the computer, and close the drive tray. You should see a Welcome screen.

- If the setup screen does not automatically appear: Use Windows Explorer to open the installation DVD, or for Download users, WIN_[your library].exe. Then start the Sample Manager by double-clicking “Install [Your Library].” setup.exe.
- You will next see an Information screen letting you know if you have other versions of ARIA or other sound libraries installed. Click “Next.”
• You will also be prompted for the folder into which the ARIA Player application, your sound files, and support files should be installed, and where the shortcuts and icons should be placed. (You will be asked later where you want the samples to be installed.) For most instances, use the default. Unless you have a more sophisticated setup, the default location is recommended. To continue, click “Next.”

• The setup lets you select which plug-in formats you require. These plug-in formats allow the ARIA Player, in addition to standalone use, to run as a virtual instrument plug-in that seamlessly integrates into your favorite music software program or sequencer (assuming that it accepts such instrument plug-ins). Please refer to the chapter “Using the ARIA Player as an Instrument Plug-In” for further information.
  • The choices are VST & RTAS
Setup is now ready to begin installing the ARIA Player and your sound library. Click on “Install” to begin the installation process. Installing library files is very resource-intensive, and it may take some time to install all the samples.

After a few moments, a dialog box will notify you that the setup wizard has finished installing the ARIA Player and your sound library on your computer.
2. The ARIA Engine Installer

- You will be automatically prompted to install the ARIA Engine component.

Follow the prompts in the ARIA Engine Setup Wizard (the “Next” button for the Information dialog, License, and Installation). After completion, you will see a screen “Completing the ARIA Engine Setup Wizard.” Click “Finish” to exit the ARIA Engine Setup and continue installation.

3. The ARIA Player Installer

- After completing the ARIA Engine Installer, you will be automatically prompted to install the ARIA Player.
Follow the prompts and select where you want the program, plug-in component (e.g. ARIA Player VST), shortcuts, and icons installed. Setup will then be ready to begin installing the ARIA Player. Click “Install”. After completion, you will see a screen “Completing the ARIA Player Setup Wizard.” Click “Finish” to exit the ARIA Player Setup and continue installation.

4. The Sound Library Installer

- After completing the ARIA Player Installer, you will be automatically prompted to install your library’s sound files. This installs all the SFZ files, banks and the actual instrument sample files.

Follow the prompts in the Setup Wizard (the “Next” button for the License Agreement, “Next” for the desired folder destination location, and “Next” for selection of Standard and/or Notation options and the instruments you want to install.
**Note:**

If you use ARIA for live play or with a sequencer, choose the “Standard” version. If you use Finale, Sibelius, or other supported notation program, select the “Notation” version. Select both if you have both a sequencer and a supported notation program. In case of doubt, install both Standard and Notation versions (it takes less than 100kb for both). The only reason we make it optional is so that people who only need one type can opt to have only that one type show in the instrument selection tree.

The installer will allow you to select or deselect specific instruments during your installation. Most users will choose the default and install all the instruments. Click “Next” to continue.

- You will then be prompted to “Select your Samples Directory.” Select the location into which you wish to install your sample library’s sound files. The default location is recommended for most users.
- You will be asked to select a Start Menu folder. The default is recommended. Click “Next” and you are ready to install the samples.
- The instrument sound files will then be copied to your hard drive. You will see screens flash by with status bars for each of the instruments being loaded.
You will see a final screen indicating that the installation is complete.

Your sound library should now be installed. You can verify this by launching ARIA and loading a sound file from your library. Once installation is complete and verified, you will need to activate your current copy of your sound library. This procedure is described in the next chapter.

When you are finished with the installation, remove the disc(s) from your drive and store them in a safe place if you have the DVD version. If you purchased the Download version, be sure to make a backup copy of the original file you downloaded. If anything happens to your computer, you can reinstall ARIA and your sound library from the discs or the backup file.

**IMPORTANT!**

Please do not cancel setup after installation begins, otherwise a partial, broken installation may result.
ACTIVATION
Activating **your Sound Library for use in ARIA Player**

After ARIA with your library is installed you will need to activate it. You will notice that when launching ARIA for the first time, the following pop-up message appears: “Your copy of [Library] is not activated. Do you want to download your Activation Keycard now?”

Click “Yes” if your computer has an internet connection, and you wish to start the easy activation process. At any time you can open your browser and go to www.garritan.biz to access our registration server. You will be presented with the Login screen. If your computer does not have an internet connection, you can register your Garritan product with any online computer, and simply copy the “Activation Keycard” to a removable USB drive, or any other method to transfer the Keycard to this computer.

If you ordered or updated online, you will have already created an account. You simply need to log in and activate with the user name and password you used when you made your purchase. If you ordered a physical boxed product, you will need to create a new account.
Log onto the Registration Site:
Log onto www.garritan.biz and enter the same username and password that you used when you made your purchase (especially Download customers).

- Creating an Account
  If you have purchased a boxed product, or have not created an account previously, you need to create an account. You will need to choose a user name and password and enter your email address.

You will then have an opportunity to enter your Profile Details. Once you do this you can amend your details at any time.
**Privacy Policy:** All personal information will be kept strictly confidential. Your information will not be shared with or divulged to any third parties for any purpose.

**Product Registration: Enter Your Serial Number:**

You will be asked to enter your serial number in order to register your product.

![Product Registration screenshot]

**Where to Find Your Serial Number:**

**Online Purchases and Updates:** If you purchased a product or update online, your serial number will be mailed to you immediately after purchase.

Thank you for shopping at [http://www.garritan.biz](http://www.garritan.biz)

Please save this email for further reference, it contains the serial numbers of the products you have just bought!

[Your Library]: 40000-11111-22222-33333-44444
**Note:**

If you have not received your serial number via email, please check your spam folder.

**Physical Boxed Products:** If you purchased a physical boxed product, the Serial Number will be affixed to the DVD case just above the DVD disc.

**The Activation Keycard**

Once the serial number is entered and you click “Register,” an Activation Keycard will be generated in your name. You can now download the “Activation Keycard” for your library. The “Activation Keycard” is an image resembling a typical credit card. This image contains your registration and profile details encoded within the Keycard image. It will look something like this:

*Note this graphic is for Personal Orchestra. Your Keycard will have the emblem of the particular library you are registering.*

After you have an account and have entered your Serial Number, you will receive an email with your Activation Keycard. The email will contain your Keycard as an attachment (.PNG file) and the message will say:

```
Dear Customer,

Attached you can find the product activation key for [your library].

Please save this email in a safe place, or save the attached product key on your hard drive. Your Activation Keycard is also available online at any time. Go to “Activation Keycards” under the Registration & Downloads tab and download the Activation Keycard for your product.
```
Your Activation Keycard is also available online at any time. Go to “Activation Keycards” under the Registration & Downloads tab and download the Activation Keycard for your product.

You can now save the “Activation Keycard” .PNG image file to your hard drive (keep it in a safe place). For convenience, we recommend that you initially save the .PNG file to your desktop.

**Final Step: Activating Your Sample Library**

Locate the Activation Keycard image where you saved it on your hard drive.

Open the ARIA standalone application. If you saved the .PNG file to your desk-top or a folder of your choosing, simply click and hold on the file, drag the file icon, or Activation Keycard image, directly onto the ARIA Player application and release.

*Drag and Drop the PNG file from the desktop onto the ARIA Player*

Drag and Drop PNG file from the Desktop onto the ARIA Standalone Application

*Alternative: Drag and Drop the Activation Keycard:* As an alternative, you can also drag the picture from the web page onto the ARIA Player itself, and it will register in most cases. Please note that not all browsers will allow “drag and drop” actions from within the program. This is another reason it is best to save the .PNG file to your desktop and “drag and drop” it from there.
You Are Now Registered and Activated!

The Activation will take place automatically and will bring up the following message: “[Your library] is now activated for [your name].”
**Extremely Important!!**

The .PNG file contains your sensitive, encrypted personal information. Carefully protect this file. **DO NOT GIVE THIS FILE TO ANYONE OR DISTRIBUTE IT IN ANY WAY OR YOUR PERSONAL INFORMATION WILL BE COMPROMISED.** IF THE FILE BECOMES PUBLIC THE CARD NUMBER WILL BE BLACKLISTED AND THE CARD REVOKED. WE ARE NOT RESPONSIBLE IF YOU GIVE YOUR PERSONAL DETAILS TO A THIRD PARTY. IF THE CARD IS STOLEN, CONTACT US IMMEDIATELY. Without a valid card you will also not be able to obtain critical updates to the program.

**Important Note:**

You are allowed a maximum of four (4) installations. If you have special circumstances or require additional licensing, please contact us.

**Updating to Latest Version:**

Be sure to check the Garritan or ARIA website for any possible updates that have occurred since the time your software was manufactured. Software is frequently updated and a more recent version may be available.
HOW TO USE THE ARIA PLAYER
How to Use the ARIA Player

Once installed and authorized, it's time to get started with the ARIA Player. There are three ways to use the ARIA Player: as a plug-in within a sequencer, with a supported notation program, or you can play it 'live' as a standalone application.

Using ARIA as a Standalone Application (‘Live’ Play)

ARIA with your library can be launched by itself and played live via MIDI keyboard or other MIDI controller. The standalone version of ARIA effectively makes your computer, audio hardware, and MIDI keyboard into a virtual music machine that can be played independently of other programs. This mode is ideal for practicing solo instruments, silent play, and live playing. The limitation is that you can usually play only one instrument at a time. Unlike using it as a plug-in within a sequencer, your recording ability is limited and you cannot edit your performance (though you can use various audio software programs for this).

Launching ARIA in Standalone Mode

First, make sure that you have followed the instructions in the installation section of this manual. Be certain that your audio/sound interface and MIDI hardware interfaces are properly connected to the computer, your speakers or headphones are connected, and everything is powered up.

To launch ARIA as a standalone application, click on the ARIA logo on your desktop or go to the Program Files or Applications folder and launch the ARIA Player.

Basic Setup Information for Standalone Mode

To use the standalone version you have to configure the Audio and MIDI settings in the ARIA Player dialog box (found in the Tools menu) before you can play. When used as a plug-in, the host sequencer or notation program has already set up its audio and MIDI connections, and the ARIA Player “plugs in” to them. However, in standalone operation, the ARIA Player communicates directly with your audio and MIDI interface. Setup for Mac and Windows computers is similar, except where indicated. Note that if you change your audio interface, you will almost certainly need to readjust these settings.
Call up the **Preferences** setup dialog from the Tools menu on the ARIA standalone interface. You’ll see drop-down menus for MIDI Devices, Audio Device API, Audio Devices, Stereo Pair, Sample Rate, and Buffer Size.

- **MIDI Devices Menu**: All supported (and installed) MIDI interfaces are available in this drop-down list. Select the desired MIDI device from the list.
- **Audio Device and Audio device API Menus**: All supported (and installed) audio interfaces are available in this drop-down list. Select the desired audio device from the list.
- **Stereo Pair**: Here you can define which of the stereo outputs should be used. It is normal to have one stereo pair available, labeled 1-2. However, many pro audio devices have multiple outputs available, in which case you may choose the one that you would like to use as the ARIA Player’s output.
- **Sample Rate**: Depending on the sound card and driver you are using, various sample rates are available. Set the desired sample rate here. Choose 44100Hz—if available—for best results.
- **Buffer Size**: The buffer size setting will determine the delay between pressing a key on your MIDI keyboard and hearing the sound (aka ‘latency’). The default buffer size of 512 samples typically works well, but smaller buffer sizes will give a faster response (lower latency) and higher buffer sizes will give better audio performance (more polyphony and higher fidelity). Most modern computers and audio interfaces can handle a buffer size of 512 samples without a significant reduction in polyphony. If the sound is breaking up or crackling when a note sounds, first make sure that the audio connections and wiring are good, then try a larger audio buffer size setting. Please note that there is typically a trade-off between higher buffer sizes (higher polyphony and sound fidelity) and lower buffer sizes (faster response or lower latency). Also note that the sound card buffer size settings determine latency, rather than the ARIA Player itself.
Once you have your Audio and MIDI set up, and have loaded one of the instrument patches, you can begin playing your library. Press (use your mouse to click on) a key on the on-screen piano keyboard on the ARIA Player interface. If you can hear the selected instrument, try playing a key on your MIDI keyboard. If the MIDI and Audio configurations are correct, you should hear the corresponding instrument. If not, check the MIDI connections and wiring, and the MIDI output channel of your MIDI keyboard.

Also check that the MIDI channel for the loaded instrument is specified correctly. By clicking the number at the far right of each instrument slot in ARIA, you may choose any desired MIDI channel, or “OM” for Omni, in which case the instrument will respond to any and all MIDI channels. If you are hearing the notes play, then the basic configuration is complete, and you are ready to use ARIA and your sound library.

**File Menu for Loading and Saving Presets in the Standalone**

Configuration presets for your particular library can be saved and loaded. This gives you the ability to customize instruments to suit personal preferences and save configurations for convenient future use. The File Menu choices are:

- **Load**—any saved configuration preset files in ARIA format can be loaded by clicking on this choice and selecting the desired file.
- **Save**—any configuration can be saved by clicking on this choice, typing a name for the custom preset, and saving to a desired location.
- **Save as default**—any settings can be saved as part of the default, to be loaded automatically each time the ARIA Player is booted in standalone mode.

**Tools Menu—Standalone Mode ONLY**

The Tools menu includes:

- **Preferences**—as described in the basic setup information above.
- **Render Offline**—MIDI files can be rendered to audio offline using this feature.

To use the Render Offline feature:

1. Click on the Load MIDI file button.
2. Select the desired MIDI file.
3. Click on the Name audio file button.
4. Name the Audio File and specify its location.
Once the files are in place, there is just one more step:

Click on the Render button. The audio file will be rendered to the specified location.

*Note:*

An alternate way to record Audio from ARIA is outlined below for users who would prefer to hear MIDI playback during the recording process.
MIDI File Player and Audio Recorder (Standalone Version Only)

The standalone version of the ARIA Player includes a MIDI File Player and Audio Recorder. They are located at the bottom of the standalone window. These features enable the user to load and play a standard MIDI file and render an audio file from it. The MIDI controls are located on the left hand side and the Audio controls on the right.

To load and play a MIDI file:
1. Click on the “Load” button.
2. Choose the file you wish to load.
3. Click on the “Play” button.

The MIDI file will play back using the presently loaded instrument and any other features (e.g. Ambience reverb) activated in the player. The progress bar will move to the right as the file is played. To start the file from the beginning, click on the “Go to Beginning” button. The file can be stopped at any time by clicking on the “Stop” button.

To record your playback to an audio file:
1. Click on the “Name File” button.
2. Name the file and specify its desired location.
3. Click on the “Record” button.
4. Start playback by clicking on the MIDI “Play” button.
5. When playback finishes, click on the MIDI “Stop” button.
6. Click on the Audio “Stop” button.

The audio file will be located on your drive in the location you specified.
Note:

There is also an offline rendering feature (explained previously) that is located in the “Tools” menu of the standalone version. Using the Audio Recorder as explained above, the MIDI file being recorded will be heard during the recording process.

Using the ARIA Player as an Instrument Plug-in

When used as a plug-in, ARIA Player is not a standalone program but rather a virtual instrument player module that is seamlessly integrated into your favorite music software program or sequencer (assuming that it accepts such instrument plug-ins). They are called “plug-ins” because they are modular software applications that run inside a “host” music application, (i.e. a sequencer or notation program, typically).

There are various uses as a plug-in:

- MIDI recording and sequencing
- Audio mixing of software instrument tracks within a single program
- Easy automation of parameters in the music software program
- Effect processing of software instrument sounds using effect plug-ins in a music software program
- Saving and recalling of all plug-in settings when the music software program or sequencer file is reloaded
- Integration with other instruments into a “virtual studio”

MIDI sequencing is akin to the old self-playing pianos. As the player pianos used mechanical techniques to reproduce performance by associating key presses and durations with holes in paper, MIDI sequencers use electronic data to record and reproduce performances. When you play a note on a MIDI keyboard, you are instructing the MIDI keyboard to play a note for a period of time, as well as how soft or loud that note will sound. The MIDI Sequencer will record and play back this data. A major advantage to using a sequencer is that all settings are saved together with the song files and are totally retained and recalled upon reload.
A great thing about plug-ins is that they work with a large variety of compatible music programs. For example, The ARIA Player can be used as a VST plug-in in many DAWs, music programs, sequencers, supported notation programs, and hosts. The ARIA Player can also be used as an Audio Units plug-in or as an RTAS plug-in.

Here is a chart describing these three plug-in standards:

<table>
<thead>
<tr>
<th>Plug-in Standard</th>
<th>Description</th>
<th>Windows</th>
<th>Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td>VST</td>
<td>The VST plug-in stands for Virtual Studio Technology and was developed by Steinberg, the makers of the Cubase family of audio programs. It is also used by Cakewalk Sonar, Mackie Tracktion, Magix Samplitude, Nuendo, FL Studio and other sequencers.</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Audio Units</td>
<td>The Audio Units (AU) plug-in standard was developed by Apple Inc. for Core Audio under Mac OS X. Audio Units is the preferred plug-in format on Mac OS X and is used by Apple GarageBand &amp; Logic and MOTU Digital Performer.</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>RTAS</td>
<td>RTAS plug-ins (Real Time Audio Suite) are designed to work in the Digidesign Pro Tools environment. Pro Tools hardware and software are used extensively in the pro audio and post-production communities.</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

**Basic Setup Information for Using the ARIA Player as a Plug-In Instrument**

To use the ARIA Player as a plug-in instrument, you simply launch your host music application/sequencer first and then launch the ARIA Player from within it. Make sure that your sequencing host program is properly installed and configured, and that it is producing sound properly. Used as a plug-in, the ARIA Player’s audio and MIDI data are managed by the host music software application.
Using the ARIA Player in a Specific Music Program or Sequencer

The ARIA Player works as a plug-in instrument within many popular music software programs. Each music software application has its own approach to handling plug-in instruments. Each has a different method of installation as well as differing means of loading and accessing plug-ins. It is important to make sure that you refer to the instructions in your music software application’s manual regarding the loading and operation of plug-in instruments.

Typically when using VSTs, the .dll files (dynamic-link libraries) associated with software instruments will all be kept in one VST folder that the host application uses to locate all available instruments (more information below).

Although it is not within the scope of this manual to delve into how plug-ins work for the various music applications, there will be tutorials on how to use the ARIA Player with the various music software programs. Please refer to the support pages on www.garritan.com/support.

Saving ARIA Player Parameters in a Music Program or Sequencer

While using the ARIA Player with a host music application, when you save a sequence or project with the host program, all of ARIA’s parameters will be automatically saved as well. You need do nothing in the ARIA Player interface for this to happen. When you re-load your host music project, your particular settings will revert to the state in which they were when you saved your project file.

Important Technical Notes:

Windows VST applications only: To use the ARIA Player with more than one VST application, you need to manually copy the ARIA Player VST_x86.dll, installed into the chosen folder during installation of the library, to the appropriate VST-compatible host application’s VST folder. Please refer to your particular application’s user’s guide and our support site for more information.

Regarding 64-bit hosts: Some hosts have one common VST folder for both x64 and 32-bit plug-ins, please only use the version of the plug-in that is native to your host, e.g.: in the x64 bit version of Sonar, use the ARIA Player VST_x64.dll. Mac OSX has standard folders for both VST and Audio Units plug-ins and does not require this extra step.
An additional copy of the VST plug-in is available within the main ARIA Player applications folder, in the VST subfolder. Please don't use this folder as your main “vstplugins” folder.

**VST Expression Support**

Some of the libraries available for ARIA support VST Expression, a new system that dramatically simplifies handling of articulations and expressions when using sample libraries within Steinberg’s Cubase. The new technology makes recording and editing articulation commands much easier, with all articulation data displayed separately in both track inspector and editor windows. More information about VST Expression can be found at the Steinberg website.

**Using ARIA with a Notation Program**

Notation is a fundamental part of music creation. Notation programs allow you to easily create and print sheet music with your computer. Until recently it was not possible to play realistic sounds from notation programs, but Garritan and Plogue have pioneered the use of notation software programs with samples.

There are two ways to use ARIA (and supported libraries) with notation programs. One is to use it directly from within a notation program that is capable of hosting plug-in instruments. The other is to use the ARIA Player in Standalone mode and route MIDI output from the notation application to the player. Recent advances in notation technology will allow you to play ARIA Player and supported sound libraries directly from within certain notation programs.

*Note:*

Some notation programs may not support software instrument plug-ins and some older versions may also lack plug-in support. Please check your notation program to make sure it supports VST or Audio Units software instrument plug-ins.

There are many resources concerning the specifics of how to use ARIA and various sound libraries with various notation programs on the [www.garritan.com](http://www.garritan.com) website including tutorials, notation files, tips, techniques, plug-ins, special programming, troubleshooting advice, and informative links.
HOW THE ARIA PLAYER WORKS
How the ARIA Player Works

The Basic Interface and the View Screens

The ARIA Player is a custom-made player developed by Plogue Art et Technologie Inc. It constitutes the best sounding and most powerful sample engine available, built from the ground up for high performance and exceptional quality. The ARIA Player enables you to load Garritan and other supported instrument sounds, control various parameters for playback, and do a number of other things. The ARIA Player has various view screens or “windows” that are accessed by the four view tabs to the right. Those screens consist of the “Mixer” window, the “Controls” window, the “Effects” window, and the “Settings” window.

The Mixer Window

1. Slot (1–16): You can have up to sixteen instruments loaded in each instance of the ARIA Player.
2. Load Instrument: Click here to load an instrument in the corresponding channel.
Clicking an instrument slot brings up a dialog box from which you can load the instrument of your choosing. The instruments will be grouped in a simple hierarchical menu by library. You can choose your instruments by instrument group: Woodwinds, Brass, Percussion, Keyboards, or the particular instrument groups your library has.

Choosing “Empty” will remove an assigned instrument from a channel. Choosing “Reload” will restore the default parameter settings for that instrument. And choosing “Import” will allow you to load an .sfz file (a patch) to use as an instrument sound.
3. **MIDI Channel Assignment:** Click the number to the right of the Instrument field to select the channel for the instrument you have loaded. If an instrument is assigned to that channel, you should see its pitch range represented on the virtual keyboard at the bottom of the window.

4. **Tune:** The “Tune” Control will allow you to make tuning adjustments to each instrument. Tuning controls are adjusted by click and drag – horizontal movements to the right make the pitch sharp. Tuning range is +/-100 cents.

5. **Output Assignment:** Here you can assign outputs. The default is channel 1 and 2 (stereo).

6. **Sends:** The Send Knob controls the amount of signal sent to the Ambience reverb for each corresponding channel.

7. **Pan Control:** This slider controls the left-to-right balance of the audio of the corresponding channel. Also see Stereo Stage control information.

**Note:**

You can CTRL-click (Command-Click on OSX) a knob to put it back to its default position.
8. **Keyboard:** The bottom of the window features a virtual onscreen keyboard that indicates the range of notes that can be played on that instrument. When a channel with an instrument assigned to it is selected, a section of the keyboard will be highlighted. Keys that are being played will be shown in real time.

![Virtual Keyboard](image)

9. **Keyswitch Identification:** This section identifies keyswitches being used. Keyswitches are used to change between techniques and articulations without the need to load separate patches. The keyswitches are displayed below the instrument’s range using the color pink. The selected keyswitch is displayed with a yellow color and the represented patch is identified in the window to the left of the keyswitches.

![Keyswitches](image)

**Note:**

In the Notation instruments all keyswitches are located in the very bottom octave. This location is below the display range of the virtual keyboard. However, the keyswitches can still be seen and chosen for testing by clicking in the space where the keyswitch name is shown. This will open a menu of the available keyswitches. You can choose a keyswitch from the menu.

![Keyswitch Menu](image)
10. Volume Control Sliders & Solo/Mute Buttons: This slider controls the relative volume level of the corresponding channel. Above the volume control sliders are the solo and mute buttons.

11. Window Selection—Mixer/Controls/Effects/Settings: These four tabs allow you to select between Mixer, Controls, Effects and Settings Windows.

12. Load Ensembles: Click here to load ensemble presets. Please refer to the section on Ensembles later in this manual.

The Controls Window

All virtual knobs in the Controls Window can be adjusted by holding down the left button of your mouse and moving it up or down (rather than in a circle, in the direction of the knob). Release the button to set the level. You can CTRL-click (Command-Click on OSX) a knob to put it back to its default position. The numerical text below the knob will give a measurement reading.
Equalizer Controls
The EQ section is a three-band equalizer, with each band having a separate gain knob (-24dB to +24 dB). The “Low” controls the filter’s gain for the bottom of the spectrum, the “Mid” controls the mid-range frequencies and the “High” controls the top end of the frequency spectrum. Adjust by placing your cursor over the desired knob, left click/hold, and move the mouse forward or backward. Release the mouse button at the desired number.

Other Library-Specific Controls:
Controls will often vary from library to library. The following are some of the controls popular in Garritan libraries.

Auto-Legato Controls (including auto-trills)
Auto-Legato is a convenient way to create smooth legato note transitions whenever note overlaps are present. This feature automatically detects note overlaps and applies changes to the attack and decay characteristics of the note transitions. There is one control button.

On/Off button. This activates/disables Auto-Legato. The button lights when activated. This switch can also be controlled using CC#102.

This control also provides auto-trills. This is an extremely convenient way to create trills. From a MIDI keyboard, just hold the first note of the trill while pressing and lifting the second note of the trill and the two notes will alternate.

Please note that Auto-Legato works monophonically and can cause loss of that instrument’s ability to play chords (polyphonically). Auto-Legato is mainly for use as an easier way to achieve legato. You may get better results with manual techniques, though they take more effort. Also, please note that if you are using a notation program, legato is handled in a different way and corresponds to CC#68.
Stereo Stage Controls

When Stereo Stage is turned off instruments can be panned from left to right in the usual way. This positions instruments left to right by relative left/right volume intensity only. When Stereo Stage is turned on it adds calculations that simulate the arrival times from the position of the instrumental sound source to a pair of virtual stereo microphones plus the first reflections from side walls, rear walls, and ceiling.

This can create a more three-dimensional image for positioning instruments on the stereo stage, both left to right and front to back, especially for monaural instruments (e.g. solo instruments that lack recorded stereo information.)

There are two controls visible on the Controls page of the interface for Stereo Stage.

1. **On/Off button.** This activates/disables Stereo Stage. The button lights when activated. This switch can also be controlled using CC#103.

2. **Depth.** This sets the position of the instrument front to back on the stereo stage. Small percentage numbers place instruments closer to the microphones; larger percentages place instruments farther back on the stage with 100% being near the back wall of the stage. The Depth parameter can also be controlled with CC#36.

When Stereo Stage is activated, the panning knobs in the mixer section of ARIA still control the left to right positioning.

**Note:**

As in real life, instruments that are placed near the microphones will display greater separation from left to right than instruments that are positioned near the back wall of the stage.

Instrument Controls

The control parameters available in this section will vary from instrument to instrument. Some instruments may have few controls and some may have many, depending on the programming of each instrument. These controls usually correspond to CC MIDI controller numbers and load with default settings.
Effects Window

The Effects tab brings up the control settings for Ambience reverb or other effects. Ambience can be used (with the send knobs) to apply flexible room reverb to the sound of a library.

The acoustic environment is integral to the overall sound of an orchestra. How the instruments blend and project to the listener can be vital to the musical performance itself. Natural reverberation or ambience is very noticeable in live orchestral performances. Since the early cathedrals that were once a focal point for musical performance, the sound of reverberation seems to impart a sense of awe and wonder. Today’s orchestras are often heard in a concert hall that also can elicit the same emotional response as it wraps and captivates the listener in sound. Concert halls have their own unique ambient sound and no two concert halls sound exactly the same. Many of the greatest halls, such as the Concertgebouw in Amsterdam, Symphony Hall in Boston, or the Great Music Hall in Vienna, were built more than 100 years ago, before the advent of modern acoustic science, yet hearing an orchestra in those spaces is breathtaking.
Reverberation describes the phenomenon that occurs whenever a sound is made in an ambient space. Whenever a sound is produced in an enclosed space it radiates in all directions. When these radiated sounds hit a surface such as a wall or the ceiling, the sound is either reflected or absorbed. The first reflected sounds are usually stronger and become more and more diffuse as the sound bounces around the room. Our ears and our brain recognize these signals and let us know about the type and size of space we are in.

Much in the same way as the acoustical space adds a great deal to the music, reverb can impart that certain three-dimensional ambient sound to an instrument or group of instruments. Reverb can also help to smooth out the sounds of the instruments and cause them to blend together in the mix by giving them a sense of space and effectively smoothing the sonic edges. Of all the effects that can be applied to music, reverb is perhaps the most widely used one, which may be because it emulates the sound that’s literally heard everywhere around us.

The ARIA Player integrates the Ambience™ Reverb—a great sounding reverb that rivals the quality of the best commercial reverbs. Just as various libraries represent “virtual instruments” designed to simulate musical instruments, Ambience allows you to simulate the reverberation of a concert hall and many other spaces. You can create virtual concert halls, ballrooms, recital halls, parlors, auditoriums, cathedrals, and other spaces.

Ambience is turned on by default and to deactivate it you must click the ON/OFF button. It is often not desirable to use Ambience reverb if you have your own reverb or convolution program.

Ambience has a number of performing space presets to choose from. These presets have been custom-made for various libraries and it is recommended that you first try out these presets. Presets from various libraries include Ballroom 1 & 2, Cathedral, Concert Hall 1 & 2, Jazz Club 1 & 2, Parlor, Piano Hall 1 & 2, and Recital Hall 1 & 2. You can also edit these presets or experiment with the various settings to customize the acoustical environment as needed.
There are a number of main knobs in the Ambience control panel. The most important parameters are reverb time (the time for the reverb to fade away), size (the size of the room), and the pre-delay time. Below is a description of the relevant controls in Ambience:

**Note:**
To control the amount of reverb for each instrument, use the Sends in the Mixer window.

- **DECAY**—This controls the time it takes for the reverb reflections to fade away into silence.
- **DIFFUSION**—Diffusion is the reflecting surface’s ability to spread the reverb out. This control has a subtle effect on the sound and is especially noticeable with small room sizes.
- **SIZE**—This controls the size of the room. Note that long reverb time and small room size do not mix well. For natural sounds, a large room size, such as a concert hall, should be accompanied by a long reverb time, and vice-versa.
- **PREDELAY**—This controls the amount of time between the direct sound and the first of the reverb reflections. It is predelay that defines our perception of the size of the room.
- **WIDTH**—This controls the stereo spread from mono (0%) all the way to a wide stereo (100%). It is recommended that the width be set close to 100%.
- **QUALITY**—This knob allows you to trade off reverb quality for CPU usage. High quality equates to high CPU usage. You can make fun effects if you set it very low (try it!). If there is too much CPU demand on your machine, try turning down the quality.
- **VARIATION**—This control creates a new variant of the same room.
- **LEVEL**—This controls the amount of the processed reverberant sound.

**Tip:**
Try using different Ambience levels for different instrument groups, assigning one level to the strings and a different level for the brass. Instruments toward the back of the stage, such as brass and percussion, may often need more reverberation than, say, the strings or woodwinds. Use the effects “Send” in the Mixer window to control the levels. Be judicious and try to avoid drowning the orchestra in too much reverb or muddying the sound with delay trails. Remember, in some smaller spaces, instruments can be fairly intimate. Ambient effects should blend as part of the sound without being perceived as something that was added. Careful and proper use of panning and equalization will also help to keep the various sections from interfering with one another. The effort to make your virtual performance spaces sound just right will prove invaluable.
Note:

It is important to bypass the on-board reverb of the ARIA Player when using Reverb or Convolution in your sequencer or host program. Otherwise you will have two simultaneous reverbs and it will sound very muddy.

Settings Window

The Settings tab brings up additional information about the ARIA Player. This screen displays the version of the software and its copyright information as well as information about how the ARIA sample engine is performing. The information in the two left-hand columns indicates the software's current CPU and RAM usage, disc efficiency, and current MIDI events and settings. You may adjust some of the settings in this window by clicking on the box to reveal a drop-down menu:
• **Dyn Max**: Determines the threshold for RAM usage by the software. The default is “256 MB” and the other choices are 128 and 512. Each time you load an instrument it will reserve RAM for the pre-caching of the first block of samples of each sound. If you are loading many instruments and exceed the default Dyn Max value, you may need to raise Dyn Max to 512.

• **Pre-Caching**: Determines how many samples of an instrument the software will process before playing them. A higher setting will result in longer initial load times, though you should increase this setting if you are using a slower computer. The default is “32 Kb.”

• **Quality**: Determines audio quality of the playback and recording. The default is “Normal (Hermite).”

• **Tuning System**: Determines the tuning system of the instrument in the software. There are different tunings for regions throughout the world, but to start, we recommend the default, “International 440.” Other choices are shown on the right.

• **Inst. Poly**: Determines the amount of polyphony (multiple notes sounding simultaneously) each instrument can play. A higher setting will allow for greater polyphony but also increase CPU usage. The default is “32.”
**Get More Sounds Button:** Clicking this button will take you to a web page where you will be able to download more instruments and sound libraries.

**Get Help Button:** Clicking this button will bring you to a support web page where you will be able to obtain help.

**Scala Import Button:** The import button provides a variety of other tunings that can be imported and used with your library. The scala file import feature enables the use of thousands of other tunings, if desired.

The following menu appears when the “Import” button is clicked:

The **Scala Center** box allows you to select the base note (or center) of your scale.
Ensembles Files (Presets)—Load Ensemble Presets Easily

The ARIA Player installation includes a folder/directory called “Ensembles” that contains a collection of useful, pre-configured instrumental combinations for the convenience of the user. Loading an Ensemble can give you a quick “head start” to setting up a group of instruments. Each file loads a selection of instruments (e.g. String Quartet or Brass Band) along with pan, level, and other settings. The Ensembles folder can be found in your library directory.

Loading Ensemble Files

There are several ways to load Ensemble preset files:

- Load from the Ensemble Manager in the upper left box of the ARIA interface.
- Drag and Drop or Load from the File menu (File/Load).

The Ensemble Manager slot is an easy way to load ensembles. When you click on the slot in the Ensemble Manager in the upper left corner of the ARIA interface, you will see a drop-down menu that will contain all of the Ensemble presets. Alternatively, you can open the “Ensembles” folder/directory to display the numbered collection of ensemble files. Using the mouse button, click and drag the file you wish to load. The instruments and their configurations will load automatically.

Note that in Standalone mode the supplied ensemble files can be customized and saved by the user. The user can also design and save custom ensemble files by loading the ARIA player with instruments; configuring level, pan, send, and other settings as desired, and saving them as “.aria” files in the File menu (File/Save As.)
CODA
Conclusion

We have presented a general picture of the ARIA Player in this guide. We have outlined how to install and use the ARIA player, the various patches and controls, and provided other salient information. You now have the finest instrument player at your fingertips. The next move is up to you.

We cordially invite you to share the music you make with ARIA with us and with others. Feel free to post your work on our forum or submit it for inclusion in our demo pages.

May you make wonderful music!
Getting Help

The first place to look for a solution to any problem you may be experiencing is in this manual. Please read the manual before contacting support. Next, check the readme files (if any) that contain important information and all last-minute changes that weren’t available when creating this guide. Whenever you encounter problems, you should also check if you have installed the latest updates. The version number of your software is displayed in the Settings tab. Updates are released regularly to fix known problems and to improve the software.

Selecting the “Get Help” button in the “Settings” tab will link directly to the Support site. The front-end will ask you for all information about your hardware and software environment, to better assist you. In your report, you should include a description of the problem, the steps you have taken to try to remedy the problem, the specs of your computer, and a description of your software and hardware.

If there is a severe technical issue (crash, empty UI), please go to the “Generate Logs” link. For Windows the link is in the Start Menu, and Mac users can find the Generate Logs link within the ARIA folder. This link will open a window and will allow you to create a log on your desktop. Please attach the log to an e-mail and send it to us. That will help us identify the issue so we can get back to you.

If you can’t find a solution to your problem by any of the above methods, please email us at support@garritan.com. The best way to get the help you need is by giving us plenty of detailed information about the problem you are having. We do ask you to read this guide thoroughly and exhaust the other avenues of support before contacting us.

Regarding Third-Party Customer Service: Please do not call Garritan for technical support regarding any other third-party application or program. Please contact the respective companies for support.

For the Latest… The ARIA Player is dynamic software that is evolving and growing. Please check the support area of our website at www.garritan.com for the latest up-to-date information, troubleshooting, FAQs, helpful hints, and tutorials. Another resource is the support forums, where you can discuss problems directly with other users and with experts from our forums.
The Garritan Community  
Learn, Share Music and Stay up to date

I invite you to join the Garritan Community.

Owning Garritan libraries and soundware gives you much more than a product. One of the most valuable benefits is membership in the Garritan community of musicians.

The Garritan Forum is where Garritan users from around the world come to discuss everything related to soundware and music. It’s the perfect way to find the latest news and announcements, ask questions, and share your music made with Garritan libraries. If you want to browse, share your music, share your thoughts about the sounds, impart knowledge, listen to demos, learn, and interact with other users—this is the place! You can also communicate privately with other musicians, respond to polls, participate in real-time chats, read how-to tutorials, and receive support and help from others. There is a wealth of information among the tens of thousands of posts in the forum and a convenient ‘search’ feature to find what you are looking for.

The Garritan forum can be accessed at: http://www.garritan.com/forum.html

You don’t have to register to browse posts, but before you can post, you will have to sign up. Registration is fast, simple and absolutely free, so please join our community today! In addition to the official Garritan Forum, there are other independent Garritan Communities where you can find valuable information and interact with other users. I urge you to contribute and be a part of the Garritan Community where you will find an indispensable resource for musicians.
Acknowledgments

Producing the ARIA Player would not have been possible without the combined help, talent, and support of many extraordinary people. I am grateful to those who have contributed and would like to thank them all.

The custom-made ARIA sample engine for this sound library was developed by Plogue Art et Technologie Inc. David Viens and his team took up the task brilliantly, and brought forth the super-charged and technologically stunning ARIA sample engine used for this project. Thanks also to Sebastien Beaulieu, Eric Patenaude, and Pascal Maheux for assisting with the development of the engine. And a special thanks to Max Deland for managing this huge project. I wish to thank Magnus Jonsson for providing a special edition of Ambience reverb.

A special thanks goes to Jeff Hurchalla. And hats off to the League of Extraordinary Beta-Testers. I wish to thank Prof. Jim Williams, Dan Kury, Bill DeWitt, Jack Cannon, Robert Davis, David Sosnowski, Pat Azzarello, Jim Ortner, Trond Bjornard Ph.D., Rick Schneblin, Randy Bowser, Jeremy & Julian Soule, Houston Haynes, Mike Moscariello, Kevin Gates, Danny Williams, Peter O'Regan, Francesco Marchetti, Colton Provias, Sean Hannifin and Alan Belkin. And thanks to James Mireau for the fantastic GUI work for ARIA and graphics. Thanks Crispin and Jeremy Soule for your help and friendship.

And a special thank you to Wendy Carlos.
Downloadable Sounds and Other Garritan Libraries!
Get More Sounds Instantly and Easily

It will soon be possible to download sounds quickly and easily to expand your musical palette. Simply go to the “Settings” tab in the ARIA Player and click on the “Get More Sounds” button. You’ll be taken to the Garritan Download shop where you will be able to download additional sounds or order complete libraries.

Please be sure to check the Authorized Steinway Virtual Concert Grand, Jazz & Big Band, Concert & Marching Band, World Instruments, and other new soundware products.

For information on all the Garritan libraries and upcoming new products, visit our website at: www.garritan.com

Products from Garritan

- Authorized Steinway Virtual Concert Grand Piano
- Personal Orchestra
- Jazz & Big Band
- Concert & Marching Band
- World Instruments (upcoming)
- Pipe Organs (upcoming)
- Orchestral Strings (upcoming)
- Reason Refills and Microsoft Songsmith Packs